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BAB III 

METODOLOGI PENELITIAN 

 

3.1 Jenis Penelitian 

Jenis penelitian yang digunakan adalah penelitian explanatory research. 

Penelitian explanatory research yaitu suatu penelitian yang menjelaskan hubungan 

antar variabel-variabel yang ada, dalam penelitian ini yang menjadi variabel 

dependen (Angka Partisipasi Kasar) dan variabel independen (PDRB, Jumlah 

Satuan Pendidikan, Rasio jumlah siswa terhadap sekolah dan Rasio jumlah siswa 

terhadap Kepala Sekolah dan Guru) melalui uji hipotesis (Usman dan Akbar, 2011).  

Melalui penerapan penelitian ini, peneliti mengharapkan akan memperoleh 

informasi yang tepat serta gambaran korelasi dari PDRB (X1), Jumlah Satuan 

Pendidikan TK (X2), Rasio siswa terhadap jumlah satuan pendidikan (X3) dan  

Rasio siswa terhadap jumlah kepala sekolah dan guru dan terhadap angka 

partisipasi kasar PAUD (Y). 

 

3.2 Desain Penelitian 

Desain penelitian merupakan gambaran secara jelas tentang hubungan antara 

varibel, pengumpulan dan analisis data. Dengan desain penelitian maka dapat 

terlihat keterkaitan antar variabel. Desain penelitian untuk pengukuran pengaruh 

variabel bebas terhadap variabel terikat digambarkan sebagai berikut: 

 

 

 

 

 

 

 

 

 

Gambar 3. 1 Desain Penelitian 
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Keterangan: 

X1 = Produk Domestik Regional Bruto (PDRB) 

X2 = Jumlah Taman Kanak kanak (JTK) 

X3       = Rasio siswa terhadap sekolah (RSSP) 

X4       = Rasio siswa terhadap Pendidik dan Pengelola (RSPP) 

Y = Angka Partisipasi Kasar (APK) 

Rx1x2y = Pengaruh X1, X2, X3 dan X4 secara simultan terhadap Y 

 

3.3 Populasi dan Sampel Penelitian 

3.1.1 Populasi Penelitian 

Sugiyono (2015) menjelaskan bahwa yang dimaksud populasi adalah wilayah 

generalisasi yang terdiri atas objek atau subjek yang memiliki kualitas dan 

karakteristik yang sama yang ditentukan oleh peneliti untuk dipelajari kemudian 

ditarik kesimpulannya. Dalam penelitian ini yang menjadi populasi penelitian 

adalah seluruh Propinsi yang ada di wilayah Negara Kesatuan Republik Indonesia. 

Jumlah total dari populasi adalah 34 Propinsi dengan rincian sebagai berikut: 

Tabel 3. 1 Populasi Penelitian 

No Propinsi Ibukota 

Jumlah 

Penduduk 

(Jiwa) 

Luas 

Wilayah 

(Km2) 

1 DKI Jakarta 8.860.381 740,29 

2 Jawa Barat Bandung 38.965.440 36.925,05 

3 Banten Serang 9.028.816 9.018,64 

4 Jawa Tengah  Semarang 31.977.968 32.799,71 

5 DI Yogyakarta  Yogyakarta 3.343.572 3.133,15 

6 Jawa Timur  Surabaya 36.294.280 46.689,64 

7 NAD  Banda Aceh 5.201.002 56.500.51 

8 Sumatera Utara  Medan 12.450.911 72.427.81 

9 Sumatera Barat Padang  4.566.126 42.224,65 

10 Riau  Pekanbaru 4.579.219 87.844,23 

11 Kepaulauan Riau Tanjungpinang 1.274.848 8.084,01 

12 Jambi Jambi 2.635.968 45.348,49 

13 Sumatera Selatan  Palembang 6.782.339 60.302,54 

14 Kep. Bangka Belitung Pangkal pinang 1.043.456 16.424,14 

15 Bengkulu  Bengkulu 1.549.273 19.795,15 

16 Lampung  Bandar Lampung 1.116.177 37.735,15 
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No Propinsi Ibukota 

Jumlah 

Penduduk 

(Jiwa) 

Luas 

Wilayah 

(Km2) 

17 Kalimantan Barat Pontianak 4.052.345 120.114,32 

18 Kalimantan Tengah  Palangkaraya 1.914.900 153.564,50 

19 Kalimantan Selatan  Banjarmasin 3.446.631 37.530,52 

20 Kalimantan Timur Samarinda 3.779.260 230.277,00 

21 Kalimantan Utara Tanjung selor 530.425 85.618,00 

22 Sulawesi Utara Manado 2.128.780 13.930,73 

23 Gorontalo  Gorontalo 922.176 12.165,44 

24 Sulawesi Tengah  Palu 2.294.841 68.089,83 

25 Sulawesi Selatan  Makassar 7.509.704 46.116,45 

26 Sulawesi Barat  Mamuju 969.429 16.787,19 

27 Sulawesi Tenggara Kendari 1.963.025 36.757,45 

28 Maluku  Ambon 1.521.539 47.350,42 

29 Maluku Utara Ternate 884.142 39.959,99 

30 Bali Denapasar 3.383.572 5.449,37 

31 NTB  Mataram 4.184.411 19.708,79 

32 NTT Kupang 4.260.294 46.137,87 

33 Papua Jayapura 1.875.388 309.934,40 

34 Irian Jaya Barat Manokwari 643.012 114.566,40 

 

Sumber: http://hanin-man.blogspot.com/2017/10/jumlah-luas-wilayah-dan-

kepadatan.html  

 

3.1.2 Sampel Penelitian 

Sampel merupakan bagian dari populasi (sebagian atau wakil populasi yang 

diteliti) menurut Arikunto (dalam Akdon & Hadi, 2008). Penelitian ini 

menggunakan sampel yang ditentukan dengan menggunakan teknik pengambilan 

sampel bertujuan (purposive sampling), yaitu teknik pengambilan sampel 

berdasarkan pertimbangan tertentu yang telah dibuat oleh peneliti. Kriteria 

pemilihan sampel dalam penelitian ini adalah sebagai berikut:  

1. Semua Propinsi yang ada di Negara Kesatuan Republik Indonesia  

2. Memiliki data APK selama 5 tahun terakhir 

3. Memiliki data PDRB selama 5 tahun terakhir 

4. Memiliki data Jumlah Satuan Pendidikan TK selama 5 tahun terakhir 
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5. Memiliki data Rasio Siswa per Sekolah selama 5 tahun terakhir 

6. Memiliki data Rasio Siswa per Pendidik dan Pengelola 5 tahun terakhir 

Dengan demikian yang menjadi sampel dalam penelitian ini berjumlah 33 Propinsi.  

 

3.4 Jenis dan Sumber Data 

Jenis data dalam penelitian ini adalah data sekunder yaitu data yang tidak diperoleh 

secara langsung. Sumber data yang digunakan dalam penelitian ini diperoleh dari Statistik 

Pendidikan Anak Usia Dini Periode 2013-2017 yang dikeluarkan oleh Pusat Data dan 

Statistik Pendidikan Kementerian Pendidikan dan Kebudayaan dan Data Publikasi Badan 

Pusat Statistik dalam laman situs https://www.bps.go.id/. 

Seperti yang telah dijelaskan sebelumnya bahwa penelitian ini bertujuan untuk 

memberikan gambaran dan membuktikan korelasi dari kelima variabel, yaitu Produk 

Domestik Regional Bruto,  Jumlah Satuan Pendidikan Taman Kanak kanak, Rasio siswa 

per sekolah, Rasio siswa per Pendidik dan pengelola, dan Angka Partisipasi Kasar 

Pengertian dari kelima variabel tersebut secara ringkas dijelaskan sebagai berikut: 

1. Variabel Operasional APK PAUD (Y) 

Angka Partisipasi Kasar (APK) adalah rasio jumlah siswa, berapapun 

usianya, yang sedang sekolah di tingkat pendidikan tertentu terhadap jumlah 

penduduk kelompok usia yang berkaitan dengan tingkat pendidikan tertentu. APK 

menunjukkan tingkat partisipasi penduduk secara umum di suatu tingkat 

pendidikan. APK merupakan indikator yang paling sederhana untuk mengukur 

daya serap penduduk usia sekolah di masing-masing tingkat pendidikan. Secara 

lebih spesifik, penelitian ini menggunakan APK Pendidikan Anak Usia Dini 

(PAUD) APK PAUD dihitung dengan formula sebagai berikut :  

𝐴𝑃𝐾𝑃𝐴𝑈𝐷 =
∑𝐽𝑢𝑚𝑙𝑎ℎ 𝑎𝑛𝑎𝑘 𝑑𝑖𝑑𝑖𝑘 𝑃𝐴𝑈𝐷

∑𝐽𝑢𝑚𝑙𝑎ℎ 𝑝𝑒𝑛𝑑𝑢𝑑𝑢𝑘 𝑢𝑠𝑖𝑎 0 − 6 𝑡𝑎ℎ𝑢𝑛
 ×  100% 

Penelitian ini menggunakan data APK yang dikeluarkan oleh Pusat Data dan 

Statistik Pendidikan Kementeran Pendidikan dan Kebudayaan. APK pada jenjang 

pendidikan anak usia dini (Y) adalah proporsi jumlah siswa yang bersekolah PAUD 

tanpa memandang usia anak, yang sedang sekolah di jenjang pendidikan PAUD 
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terhadap jumlah penduduk pada rentang usia 0-6 tahun (dini) yang dinyatakan 

dalam persen (%). 

  

2. Variabel Operasional PDRB (X1) 

Seperti yang telah dijelaskan pada Bab sebelumnya bahwa PDRB dapat 

disusun melalui 3 (tiga) pendekatan yakni dihitung dari pendapatan, pengeluaran 

dan produksi. Pada penelitian ini PDRB yang digunakan adalah dari pendekatan 

pengeluaran. 

Pendekatan pengeluaran PDRB adalah komponen permintaan terakhir yang 

terdiri dari :  

1. Pengeluaran komsumsi rumahtangga dan lembaga swasta nirlaba  

2. Konsumsi pemerintah  

3. Pembentukan modal tetap domestic bruto  

4. Perubahan stok  

5. Ekspor neto (ekspor neto merupakan ekspor dikurangi impor).  

Secara konsep ketiga pendapatan tersebut akan menghasilkan angka yang 

sama. Jadi, jumlah pengeluaran akan sama dengan jumlah pendapatan untuk faktor- 

faktor produksi.  

 

3. Variabel Operasional Jumlah Satuan Pendidikan (X2) 

Menurut Undang-undang nomor 20 tahun 2003 tentang Sistem Pendidikan 

Nasional pada Pasal 1 Angka 10 yang dimaksud dengan satuan Pendidikan adalah 

kelompok layanan pendidikan yang menyelenggarakan pendidikan pada jalur 

formal, nonformal, dan informal pada setiap jenjang dan jenis Pendidikan. Dalam 

penelitian ini satuan pendidikan Pendidikan Anak Usia Dini pada Jenjang Taman 

Kanak kanak yang ada di setiap Propinsi di Indonesia dari tahun 2013 – 2017.  

 

4. Variabel Operasional Rasio Siswa Per Sekolah  (X3) 

Rasio siswa per sekolah adalah jumlah rata-rata siswa dalam satuan pendidikan 

tertentu, semakin kecil angka rasio siswa per sekolah maka mutu Pendidikan akan 
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semakin baik karena rasio ini berhubungan dengan kepadatan kelas. Semakin kecil 

angka rasio siswa per sekolah maka kepadatan siswa dikelas semakin kecil sehingga 

guru lebih mudah meperhatikan siswa 

 

5. Variabel Operasional Rasio Siswa Per Pendidik dan Pengelola (X4) 

Menurut Permendikbud No 137 tahun 2014 tentang Standar Nasional 

Pendidikan Anak Usia Dini pasal  36 bahwa rasio guru per siswa dibagi dalam 

kelompok umur sebagai berikut : 

a. Usia Lahir-2 tahun: rasio guru dan peserta didik 1: 4.  

b. Usia 2-4 tahun: rasio guru dan peserta didik 1: 8 

c. Usia 4-6 Tahun: rasio guru dan peserta didik 1:15  

Karena data dalam penelitian ini menggunakan rasio siswa TK terhadap guru 

sehingga rasio yang digunakan adalah 1:15, angka ini berarti satu orang guru bisa 

menangani 15 orang anak mengacu pada standar nasional PAUD. Jika angka rasio 

siswa per guru mendekati 15 maka diharapkan kualitas pembelajaran akan lebih 

baik lagi.   

Tabel 3.2 Variabel Operasional Penelitian 

Jenis 

Variabel 

Nama 

Variabel 
Definisi Satuan  Sumber 

Dependen 

Angka 

Partisipasi 

Kasar PAUD 

(APK) 

Merupakan 

indicator yang 

paling sederhana 

untuk dapat 

mengukur daya 

serap penduduk 

terhadap 

Pendidikan pada 

jenjang PAUD 

% 

Kementerian 

Pendidikan dan 

Kebudayaan  

Independen 

Produk 

Domestik 

Regional 

Bruto (PDRB) 

salah satu indikator 

untuk melihat 

tingkat percepatan 

perekonomian 

suatu daerah, 

karena PDRB 

adalah produk 

barang dan jasa 

akhir yang 

dihasilkan dalam 

Rp 

Publikasi 

Badan Pusat 

Statistik 



81 

 

Yoris Kartakusumah, 2018 
ANALISIS FAKTOR YANG MEMPENGARUHI ANGKA PARTISIPASI KASAR (APK) PADA PENDIDIKAN ANAK 
USIA DINI TAMAN KANAK-KANAK 
Universitas Pendidikan Indonesia | repository.upi.edu | perpustakaan.upi.edu 

Jenis 

Variabel 

Nama 

Variabel 
Definisi Satuan  Sumber 

suatu wilayah 

dengan dukungan 

faktor-faktor 

produksi dalam 

wilayah tersebut 

Independen 
Jumlah TK 

(JTK) 

Jumlah satuan 

Pendidikan pada 

jenjang TK di 

Seluruh Wilayah 

Indonesia 

Ruang/buah 

Kementerian 

Pendidikan dan 

Kebudayaan 

Independen 

Rasio Siswa 

Per Sekolah 

(RSPS) 

 Perbandingan 

jumlah siswa 

terhadap sekolah 

Siswa/sekolah  

Kementerian 

Pendidikan dan 

Kebudayaan 

Independen 

Rasio Siswa 

Per Guru dan 

Kepala 

Sekolah 

(RSPG) 

Perbandingan 

jumlah murid 

terhadap guru dan 

kepala sekolah 

Siswa/guru 

Kementerian 

Pendidikan dan 

Kebudayaan 

 

 

3.5 Metode dan Model Penelitian  

3.5.1 Metode Pengumpulan Data  

Data yang digunakan dalam penelitian ini adalah data sekunder time series dan 

cross section (panel data) tahun 2013-2017 dalam bentuk tahunan. Data yang 

digunakan berasal dari berbagai sumber seperti Kementerian Pendidikan dan 

Kebudayaan dan Badan Pusat Statistik. Data tersebut adalah Angka Partisipasi 

Kasar (APK) PAUD  33 Propinsi periode tahun 2013-2017, Produk Domestik 

Regional Bruto Pengeluaran 33 Propinsi di wilayah Indonesia, Jumlah Taman 

Kanak kanak periode tahun 2013-2017, Rasio siswa per sekolah di 33 Propinsi 

Priode tahun 2013-2017, dan Rasio siswa per guru pada periode 2013-2017. 

 

3.5.2 Metode Pengolahan Data 

Metode analisis yang digunakan dalam penelitian ini adalah analisis deskriptif 

kualitatif dan kuantitatif. Analisis deskriptif kualitatif digunakan berbagai studi 

literatur yang bersumber dari jurnal, working paper, artikel, buku- buku dan hasil 

penelitian terdahulu, sedangkan analisis kuantitatif penelitian ini menggunakan 
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model ekonometrika yang dapat menjelaskan hubungan antara variabel-variabel 

yang digunakan dalam penelitian ini. Teknik pengolahan data pada penelitian ini 

menggunakan metode regresi Ordinary Least Square (OLS) dengan menggunakan 

model data panel (panel data regression model), karena data-data yang akan diolah 

merupakan pooling cross section observation yang diperoleh dan diteliti sejalan 

dengan perubahan waktu. Model data panel ini memiliki ruang dan dimensi waktu, 

sehingga estimasi variabel dan hasil perhitungan akan memberikan analisis empiris 

yang lebih luas (Basic Econometrics, 2003). Untuk mempermudah proses estimasi 

data digunakan bantuan program komputer Eviews versi 9 dan Microsoft Excel 

2016.  

 

3.5.3 Model Penelitian  

Secara umum estimasi model regersi data panel yang merupakan gabungan 

data time series dan cross section adalah sebagai berikut : 

𝑌𝑖𝑡 = 𝛼 + 𝛽1𝑋1𝑖𝑡 +  𝛽2𝑋2𝑖𝑡 + ⋯ + 𝛽𝑛𝑋𝑛𝑖𝑡 +  ℮𝑖𝑡 

Dimana :  

𝑌𝑖𝑡 = 𝑉𝑎𝑟𝑖𝑎𝑏𝑒𝑙 𝑡𝑒𝑟𝑖𝑘𝑎𝑡 (𝑑𝑒𝑝𝑒𝑛𝑑𝑒𝑛) 

𝑋𝑖𝑡 = 𝑉𝑎𝑟𝑖𝑎𝑏𝑒𝑙 𝑏𝑒𝑏𝑎𝑠 (𝑖𝑛𝑑𝑒𝑝𝑒𝑛𝑑𝑒𝑛𝑡) 

𝛼 = 𝐾𝑜𝑛𝑠𝑡𝑎𝑛𝑡𝑎 𝑟𝑒𝑔𝑟𝑒𝑠𝑖/ 𝑖𝑛𝑡𝑒𝑟𝑠𝑒𝑝 

𝛽𝑖 = 𝐾𝑜𝑒𝑓𝑖𝑠𝑖𝑒𝑛 𝑟𝑒𝑔𝑟𝑒𝑠𝑖 /𝑠𝑙𝑜𝑝𝑒 

℮𝑖𝑡 = 𝑘𝑒𝑠𝑎𝑙𝑎ℎ𝑎𝑛 𝑝𝑒𝑛𝑎𝑘𝑠𝑖𝑟𝑎𝑛  

𝑖 =  𝑒𝑛𝑡𝑖𝑡𝑎𝑠 𝑘𝑒 𝑖 

𝑡 = 𝑝𝑒𝑟𝑖𝑜𝑑𝑒 𝑘𝑒 𝑡 

Dalam penelitian ini, akan dicoba dengan empat variabel bebas dengan satu 

variabel tak bebas, yang diharapkan dapat memunculkan sebuah model regresi 

linear.  
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3.6 Metode Pengujian  

3.6.1. Penentuan Model Regresi  

Menurut Disman (2010) dalam Dewi (2014) model regresi dengan data panel, 

secara umum mengakibatkan kesulitan dalam menentukan spesifikasi modelnya. 

Residualnya akan mempunyai dua kemungkinan yaitu residual time series, cross 

section maupun keduanya. Beberapa metode yang bisa digunakan untuk 

mengestimasi model regresi dengan data panel. Pembahasan secara detail yaitu 

pendekatan Fixed Effect dan pendekatan Random Effect. Teknik yang paling 

sederhana untuk mengestimasi data panel adalah dengan mengkombinasikan data 

time series dan cross section dengan menggunakan metode OLS (estimasi common 

effect). Pendekatan ini tidak memperhatikan dimensi individu maupun waktu. 

Menggunakkan asumsi bahwa perilaku antar individu dan kurun waktu yang sama. 

Meskipun koefisien regresor dapat dikatakan sama, model ini tetap menunjukkan 

perbedaan konstanta antar objek. Model ini yang kemudian kita kenal dengan 

regresi Fixed effect (efek tetap).  

Mengestimasikan data panel dengan fixed effects melalui teknik variabel 

dummy menunjukan ketidakpastian model. Asumsi intersep dan slope dari 

persamaan regresi yang dianggap konstan baik antar daerah maupun waktu menjadi 

kesulitan dalam pendekatan ini. Mengatasi masalah ini kita bisa menggunakan 

variabel residual yang dikenal sebagai metode Random Effects. Model ini kita akan 

memilih estimasi data panel dimana residual mungkin saling berhubungan antar 

waktu dan antar individu. (Wahyu, 2011) menyatakan untuk menentukan model 

estimasi data panel ada beberapa alternatif pendekatan yang dapat digunakan untuk 

mengestimasi data panel disesuaikan dengan asumsi yang digunakan:  

3.6.1.1 Pendekatan Kuadrat Terkecil (Pooled Least Square) 

Dalam pengolahan panel data pendekatan yang paling sederhana adalah dengan 

menggunakan metode kuadrat terkecil biasa yang diterapkan dalam data yang berbentuk 

pool. Memasukkan variabel boneka (dummy variable) merupakan cara yang sering 

dilakukan untuk mengizinkan terjadinya perbedaan nilai parameter yang berbeda-beda baik 

lintas unit cross section maupun antar waktu. Pendekatan dengan memasukkan variabel 

boneka ini dikenal dengan sebutan model efek tetap (fixed effect) atau Least Square 
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Dummy Variable (LSDV) atau disebut juga Covariance Model. Rumus estimasi dengan 

menggunakan pooled least square sebagai berikut: 

𝑌𝑖𝑡 =  𝛽1 + 𝛽2 +  𝛽3 𝑋𝑖𝑡 + ⋯ +  𝛽𝑛𝑋𝑛𝑖𝑡 +  𝜇𝑖𝑡   

 

3.6.1.2 Pendekatan Efek Tetap (Fixed Effect) 

Setiap objek mempunyai perbedaan, pada suatu waktu memiliki kemungkinan 

berbeda di setiap waktu dan kondisi. Diperlukan suatu model yang dapat 

menunjukkan perbedaan konstan antar objek, meskipun dengan koefisien regresor 

yang sama. Untuk membedakan satu objek dengan objek lain, digunakan variabel 

semu (dummy). Pendekatan dengan memasukkan variabel boneka dikenal dengan 

sebutan model efek tetap (fixed effect) atau Least Squares Dummy Variables 

(LSDV). Keputusan untuk memasukkan variabel boneka dalam model efek tetap 

tak dapat dipungkiri akan dapat menimbulkan konsekuensi (trade off). Penambahan 

variabel boneka ini akan dapat mengurangi banyaknya derajat kebebasan (degree 

of freedom) yang pada akhirnya akan mengurangi efisiensi dari parameter yang 

diestimasi. Persamaan model ini adalah sebagai berikut: 

𝑌𝑖𝑡 =  𝛼1 + 𝛼2𝐷2 + ⋯ + 𝛽2𝑋𝑖𝑡 + ⋯ + 𝛽𝑛𝑋𝑛𝑖𝑡 + 𝜇𝑖𝑡 

 

3.6.1.3 Pendekatan Efek Acak (Random Effect) 

Model ini lebih dikenal sebagai model generalized least squares (GLS). 

Tanpa menggunakan semua variabel, metode efek acak menggunakan residual, 

yang diduga memiliki hubungan antar waktu dan antar objek. Parameter-parameter 

yang berbeda antar daerah dan antar waktu dimasukkan ke dalam error. Oleh karena 

itu, model efek acak (random effect) sering juga disebut model komponen error 

(error component model). Namun untuk menganalisis dengan metode efek random 

ini ada satu syarat, yaitu objek data silang harus lebih besar daripada banyaknya 

koefisien. Rumus estimasi dengan menggunakan random effect sebagai berikut: 

𝑌𝑖𝑡 = 𝛽1 + 𝛽2𝑋2𝑖𝑡 + ⋯ + 𝛽𝑛𝑋𝑛𝑖𝑡 + 𝜀𝑖𝑡 + 𝜇𝑖𝑡 
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3.6.2. Pengujian Model   

Untuk memilih model yang tepat, ada beberapa uji yang harus dilakukan. 

Pertama, menggunakan uji signifikansi fixed effect uji F atau Chow-test. Kedua, 

dengan uji Hausman. Chow test atau likelihood ratio test adalah pengujian F 

Statistics untuk memilih apakah model yang digunakan Pooled Least Square (PLS) 

atau fixed effect. Sedangkan uji Hausman adalah uji untuk memilih model fixed 

effect atau random effect (Winarno, 2011).  

3.6.2.1. Uji Chow-test (pool vs fixed effect) 

Uji signifikansi fixed effect (uji F) atau Chow-test adalah untuk mengetahui 

apakah teknik regresi data panel dengan fixed effect lebih baik dari model regresi 

data panel tanpa variabel dummy atau OLS. Adapun uji F statistiknya sebagai 

berikut:  

𝐶𝐻𝑂𝑊 =  
(𝑅𝑅𝑆𝑆 − 𝑈𝑅𝑆𝑆)/(𝑁 − 1)

𝑈𝑅𝑆𝑆/(𝑁𝑇 − 𝑁 − 𝐾)
 

Keterangan:  

RRSS   = Restricted Residual Sum Square (Merupakan Sum of Square Residual 

yang diperoleh dari estimasi data panel dengan metode pooled least 

square/common intercept)  

URSS    = Unrestricted Residual Sum Square(Merupakan Sum of Square Residual 

yang diperoleh dari estimasi data panel dengan metode fixed effect) 

N = Jumlah Data Cross Section 

T = Jumlah Data Time Series 

K = Jumlah Variabel Penjelas 

Dasar pengambilan keputusan menggunakan chow-test atau likelihood ratio 

test, yaitu:  

1. Jika H0 diterima, maka model pool (common).  

2. Jika H0 ditolak, maka dilanjutkan uji Hausman.  

Jika hasil uji Chow menyatakan H0 diterima, maka teknik regresi data panel 

menggunakan model pool (common effect) dan pengujian berhenti sampai di sini. 

Apabila hasil uji Chow menyatakan H0 ditolak, maka langkah selanjutnya adalah 
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melakukan uji Hausman untuk menentukan model fixed atau model random yang 

akan digunakan.  

 

3.6.2.2. Uji Hausman 

Pengujian ini digunakan untuk menentukan model yang paling tepat dalam 

penelitian yang menggunakan data panel. Dalam Uji Hausman terdapat 2 

kemungkinan metode yang akan digunakan, yaitu fixed effect dan random effect.  

Apabila hasil dari nilai statistika Hausman lebih besar dari nilai kritisnya, 

maka model yang tepat untuk digunakan adalah Fixed Effect Model. Jika nilai yang 

dihasilkan dari Hausman lebih kecil dari nilai kritisnya maka model yang tepat 

untuk digunakan adalah Random Effect Model.  

Untuk menentukan apakah model Fixed Effect atau model Random Effect 

yang digunakan, maka digunakan hipotesis dalam pengujian Hausman yaitu:  

 H0 : tidak ada kesalahan pengukuran error (kovarians error) atau individual 

effect tidak berhubungan dengan regressor yang lain, berarti model 

menggunakan Random Effect Model (REM)  

 H1 : ada kesalahan pengukuran error (kovarians error) atau individual effect 

berhubungan dengan regressor lain, berarti model menggunakan Fixed Effect 

Model (FEM)  

Dengan kriteria : 

1. Nilai chi-square stat > chi-square tabel, pada α = 0,05, maka H0 ditolak  

2. Nilai chi-square stat < chi-square tabel, pada α = 0,05, maka H0 tidak ditolak  

Jadi apabila H0 ditolak, estimasi model panel akan menjadi lebih baik dengan Fixed 

Effect Model. Namun, jika H0 tidak dapat ditolak maka estimasi model akan menjadi 

lebih baik dengan menggunakan Random Effect Model (Gujarati, 2004) 

 

3.6.3. Uji Statistik  

3.6.3.1. Uji Signifikansi t  
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Uji t digunakan untuk mengetahui pengaruh dari variabel independen 

terhadap variabel dependen secara individu dalam tingkat signifikansi tertentu 

dengan hipotesis sebagai berikut :  

 H0 : βi = 0, (variabel independen tidak memiliki pengaruh yang signifikan 

terhadap dependen)  

 H1 : βi ≠ 0, (variabel independen memiliki pengaruh yang signifikan 

terhadap variabel dependen)  

Kriteria penerimaan dan penolakan hipotesis nol (H0) adalah sebagai 

berikut:  

 H0 tidak ditolak jika : (t-tabel) ≤ (t-stat) ≤ (t-tabel)  

 H0 ditolak jika : -(t-stat) < -(t-tabel) atau (t-stat) > (t-tabel) Apabila H0 

ditolak, pengaruh dari variabel independen terhadap variabel dependen 

signifikan. Namun, jika H0 tidak ditolak maka pengaruh dari variabel  

independen terhadap variabel dependen tidak signifikan. 

 

3.6.3.2. Uji Signifikansi F 

Uji signifikansi F ini dilakukan untuk melihat pengaruh variabel independen 

terhadap variabel dependen sebagai suatu kesatuan dalam tingkat signifikansi 

tertentu dengan hipotesis sebagai berikut : 

 H0 : β1 = β2 = ... βi = 0, (semua variabel independen secara bersama- sama 

tidak berpengaruh terhadap variabel dependennya)  

 H1 : β1 ≠ β2 = ... βi ≠ 0, (paling tidak terdapat salah satu variabel independen 

berpengaruh terhadap variabel dependennya)  

Adanya kriteria untuk mengetahui hasil dari hipotesis diatas. Kriterianya 

adalah :  

F-stat > F-tabel, H0 ditolak 

F-stat ≤ F-tabel, H0 tidak ditolak 

Apabila H0 ditolak maka terdapat minimal satu variabel independen yang dapat 
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berpengaruh terhadap variabel dependennya. Namun, jika H0 tidak ditolak maka 

seluruh variabel independen tidak berpengaruh terhadap variabel dependennya.  

 

3.6.3.3. Koefisien Determinasi (adjusted R2) 

Koefisien determinasi R2 digunakan untuk mengukur seberapa besar 

kemampuan variasi variabel independen dalam menjelaskan variasi variabel 

dependen pada model yang dipakai. Besarnya nilai R2 adalah 0 ≤ R2 ≤ 1, dimana 

semakin R2 mendekati 1 maka dapat dikatakan model tersebut lebih baik, karena 

variasi pada variabel independen dapat menjelaskan variasi pada variabel 

dependennya. Jika nilai koefisien determinasinya mendekati 0 berarti dapat 

dikatakan model tersebut kurang baik, karena variasi variabel independennya 

kurang mampu menjelaskan variasi variabel dependennya.  

 

3.6.4. Pengujian Masalah dalam Regresi Linear 

3.6.4.1 Uji Heteroskedastisitas 

Uji heterokedastisitas digunakan untuk mengetahui situasi dimana varians 

dari setiap error terms tidak lagi konstan. Heteroskedastisitas adalah adanya 

kesamaan varian dari residual pada semua pengamatan dari model regresi penelitian  

(Nazaruddin & Basuki, 2016). Uji heteroskedastisitas dilakukan untuk mengetahui 

adanya penyimpangan dari syarat-syarat asumsi klasik pada model regresi, karena 

dalam model regresi mempunyai syarat tidak adanya heteroskedastisitas. Uji 

heteroskedastisitas pada penelitian ini menggunakan uji glejser. Kriteria pada 

pengujian ini apabila nilai signifikansi > 0,05 maka tidak terjadi heteroskedastisitas. 

Model regresi yang memenuhi persyaratan yaitu mempunyai kesamaan varians dari 

residual satu pengamatan ke pengamatan yang lain tetap atau homokedastisitas. Uji 

glejser dilakukan dengan meregres nilai absolut residual terhadap variabel 

independen (Ghozali, 2016)  

  

3.6.4.2 Uji Multikolinearitas 
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Multikolinearitas merupakan masalah yang terdapat pada variabel-variabel 

independen yang memiliki ikatan yang erat atau hubungan yang saling 

berpengaruh. Deteksi asalah multikolinearitas dengan cara melihat apabila R2-nya 

memiliki nilai yang tinggi tetapi hanya beberapa atau tidak ada variabel independen 

yang signifikan pada uji t. Salah satu cara untuk mengetahui variabel independen 

mana yang berhubungan dengan variabel independen lainnya adalah dengan 

melakukan regresi pada satu variabel independen terhadap variabel independen 

lainnya dan menghitung R2-nya. Apabila nilai R2 pada hasil regresi tersebut lebih 

kecil dari nilai R2 hasil perhitungan regresi output terhadap variabel input secara 

keseluruhan, maka dalam model tidak terdapat masalah multikolinearitas.  

 

3.6.5. Proses Penginputan Data dalam eViews 

 
Berikut merupakan langkah-langkah proses input data excel kedalam software 
eviews : 

 Buka file excel ,kemudian ketik lah data yang akan di olah  

 Data yang digunakan dalam penelitian ini adalah Y, X1 ,X2, X3 
dan X4 dimana data tersebut merupakan data dari 33 Propinsi yang ada di 
Indonesia.. 
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 Ctrl A, (atau di blok semua data yang akan di gunakan) kemudian klik 
kanan 

 Format cell => Number => Ok 
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 File => Save as 

http://4.bp.blogspot.com/-2vuEBn-RlIs/VXTSGk2TqZI/AAAAAAAAB0g/-8CKUWVWH28/s1600/4.PNG
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 Pilih Save as type nya Excel 97-2003 workbook=> klik Ok 

http://4.bp.blogspot.com/-Q0WN0uABFGM/VXTSGWxpT-I/AAAAAAAAB0M/IcydzD-QdKI/s1600/2.PNG
http://2.bp.blogspot.com/-dpfpV1uVzPU/VXTSGqa4LcI/AAAAAAAAB0Q/uBwul8ptVLg/s1600/3.PNG
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 Kemudian Close file excel 

Kemudian kita selanjutnya bekerja di EViews 
 
 File => New => workfile 

 isi "start date" dengan tahun awal dan "end date" untuk tahun akhir data 
(sebagai contoh data dimulai pada tahun 2013 dan berakhir tahun 2017) => 
klik ok 

 

 
 

 
 
 Kemudian Pilih Object => New Object 

http://2.bp.blogspot.com/-h_7CW5kU3OY/VXTSHUOWX0I/AAAAAAAAB00/BvDWebXz8FM/s1600/5.PNG
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 Pada "Type of Object" Pilih Pool dan isi "Name for Object" sesuai 
keinginan => klik ok 

 

http://3.bp.blogspot.com/-jGGUA3kwH6I/VXTSHkMQfrI/AAAAAAAAB0k/mFM4n2hQJ4k/s1600/6.PNG
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 Setelah itu maka akan keluar jendela "Pool", kemudian dibawah tulisan 
cross section Identifiers below.... di isi dengan nama (objek) misalnya disini saya 
menggunakan nama Provinsi, untuk setiap penulisan objek di awali tanda "_" 
(underscore) 

http://4.bp.blogspot.com/-_Qj2rKxU1D4/VXTSH4kQhzI/AAAAAAAAB0o/XOgHq7r6j1o/s1600/7.PNG
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 Setelah di isi kemudian klik menu Proc => Import pool data 

 

 

http://2.bp.blogspot.com/-UBrAOTBBaio/VXTSIXAucrI/AAAAAAAAB08/bsZFoPKMoAE/s1600/8.PNG
http://3.bp.blogspot.com/-5eLvur5M7ag/VXTSIUW15VI/AAAAAAAAB04/mhaUeAFHkcE/s1600/9.PNG
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 Pilih data yang akan diinput (misalnya data saya namya PANEL) => 
kemudian klik Open 

 

 
 Untuk upper-left data cell isi sesuai dengan permulaan data berada, 
misalnya di cell B2 (jika data anda dimulai pada cell lainnya misalnya 
pada C2 maka isi dengan C2) pada excel 

http://1.bp.blogspot.com/-8sF2LnkIVok/VXTSD4QcpZI/AAAAAAAABzc/8YyClFjnY58/s1600/10.PNG
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 untuk kotak "ordinary and pool" isikan semua var dependen dan 
independen diikuti tanda tanya "?"  (dalam hal ini saya menggunakan variabel Y 
X1 X2 dan saya input menjadi y? x1? x2?) kemudian =>> klik Ok 

 

 
 

http://1.bp.blogspot.com/-GnhO01qi3PQ/VXTSDnoZHBI/AAAAAAAABzg/VVr6KfvlnQU/s1600/11.PNG
http://1.bp.blogspot.com/-RjpsJZ5bxxs/VXTSE121ToI/AAAAAAAABz4/JhwAZcADkBI/s1600/12.PNG
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Jika data berhasil di input maka hasilnya akan seperti ini... 
 

 
 
 
Untuk cek data apakah sudah masuk atau tidak, begini caranya : 
 
 Blok semua objek dari "x1_aceh sampai y_sumut"  

 klik kanan =>> open as group 

 

http://2.bp.blogspot.com/-NTjtFMmOR-s/VXTSE3ED83I/AAAAAAAABz0/wmRw3BVOSIA/s1600/13.PNG
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Setiapa Variabel data sudah terisi 

 
 
 Nah jika sudah terisi maka data panel siap untuk di regresi, 
baik common effect, fixed effect, redundant test, uji 
hausman maupun random effect 

 

 

 

 

 

 

 

http://4.bp.blogspot.com/-5X02ND85TkU/VXTSFP7pAGI/AAAAAAAABz8/NrQNqyQ7MvU/s1600/14.PNG

